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Premessa
Credo sia doveroso ricordare prima di tutto due radioamatori che hanno fatto
la storia dell’APRS. Senza di loro tutto questo non sarebbe possibile.

Bob Bruninga WB4APR, ingegnere della US Navy che ha inventato il sistema
APRS. (http://cadigweb.ew.usna.edu/~bruninga/aprs.html)

Roger Barker G4IDE, prematuramente scomparso |I'8 settembre 2004 poco
piu che cinquantenne. Autore di UI-View. Il migliore e piu sviluppato software
per APRS. Ha lasciato un vuoto incolmabile.

Qualche nota per quanto riguarda lo scrivente. Sono nato nel ‘59, abito a
Crema (CR) e sono sposato con Cristiana IW2NVI - KCOQXT che €& il mio
“supporto morale” in tanti momenti della mia attivita radio. Lavoro
all’aeroporto di Linate nel settore operativo. Ho ottenuto il nominativo nel
1983 ed il mio interesse per la radio € sempre stato orientato verso le HF e la
caccia al DX. Ho conseguito |I" Honor Roll nel 2005 e nel 2006 ho raggiunto
I'obiettivo di aver collegato e confermato tutte le entita DXCC. Nei primi anni
2000 ho sostenuto gli esami radioamatoriali USA ottenendo la Extra Class ed il
nominativo K2CHZ. Nel 1999 ho iniziato ad interessarmi anche all’ APRS. Sono
stato una delle primissime stazioni APRS della Lombardia e credo di averlo
sperimentato un po’ in tutte le modalita: VHF, HF, internet, mobile (auto,
moto, altro) e su piattaforme diverse: pc desktop, portatili e PDA. Ho
realizzato le prime mappe per UI-View e dal novembre 2004 ho installato a
casa mia wuna stazione meteorologica attiva H24 che trasmettere
ininterrottamente i dati meteo APRS sia via radio che via internet.



Introduzione

Che cos’e I'APRS?

E’ un sistema di comunicazione che si basa sulla trasmissione di dati digitali
che trasportano varie informazioni. I dati sono normalmente in modulazione
AFSK 1200 Bd, il cosiddetto packet, ma in modalita non connessa e quindi
senza la certezza che il destinatario riceva correttamente cio che e stato
trasmesso, ma proprio per questo motivo si ha la diffusione su vasta scala del
segnale. Piu precisamente si tratta di pacchetti UI (Unnumbered Information)
da qui il nome del programma piu usato per I’APRS: UI-View.

L" APRS serve a trasmettere dati di stazioni fisse, posizione di stazioni in
movimento, dati meteo di stazioni meteorologiche, messaggi fra due o piu
stazioni, bollettini, avvisi, interrogazioni ad altre stazioni, ritrasmettere dati di
altre stazioni.

Lo scopo principale dell’APRS ¢ soprattutto di fornire informazioni in grandi
aree locali e questo scambio di informazioni deve avvenire nel modo piu
affidabile possibile. L'’APRS non e fatto per tentare le comunicazioni a grande
distanza o i DX ma per un impiego tattico locale. La sua applicazione ideale &
in campo di protezione civile. Citando l'inventore dell’ APRS Bob Bruninga
"APRS is a real-time tactical digital communicatons protocol for exchanging
information between a large number of stations covering a large (local) area.
As a multi-user data network, it is quite different from conventional packet
radio.”

Da qui il mio intento di dare delle indicazioni sulla configurazione per fare in
modo che sia davvero affidabile.

Cosa serve per fare APRS?

Per stazione fissa € necessario un computer, un TNC o un modem Baycom o
anche la sola scheda audio del computer ed un normale RTX FM su 144.800
MHz. In alternativa al TNC e al RTX VHF si puo utilizzare una radio dedicata
con modem integrato come il Kenwood TM-D700 o TH-D7 collegati
direttamente al computer.

Per la stazione mobile serve un GPS con uscita NMEA 0183 seriale, un RTX
dedicato per APRS come i Kenwood TM-D700 o TH-D7 oppure un normale RTX
FM su 144.800 ed un interfaccia tipo Tiny Trak od alcuni tipi di TNC.



Considerazioni

Scrivo questi consigli in seguito ad alcune osservazioni fatte in questi anni di
attivita in APRS, dal lungo monitoraggio del traffico e dal chiedermi il perché
delle cose.

Le stazioni attive sono ormai da anni molte. Osservando le configurazioni dei
vari utenti mi sono reso conto che la prima causa del QRM, e quindi della
scarsa efficienza del sistema, siamo noi stessi. Per rendersene conto basta
ascoltare l'audio a 144.800, si sentono molti pacchetti trasmessi
contemporaneamente, € una collisione continua ed il rapporto fra quanto
ascoltato e quanto effettivamente € demodulato & bassissimo.

Premesso che risolvere totalmente il problema & impossibile perché &
intrinseco nella filosofia di funzionamento dell'APRS, ossia |'essere tutti sulla
stessa frequenza e in modalita non connessa, adottando opportuni
accorgimenti si potrebbe migliorare notevolmente la situazione.



Criteri di configurazione

I principali punti su cui intervenire sono cinque:

Frequenza di invio del beacon.
Indirizzamento del beacon.
Configurazione digipeater.
Messaggistica

Varie

ke

Capitolo 1: frequenza di invio del beacon.

Il beacon e il messaggio che contiene il nominativo di chi lo invia, la codifica
dell'icona che identifica il tipo stazione, la posizione ed altre informazioni. E’
quello che ci fa apparire sulla mappa degli altri utenti, se ricevuto...

Molte stazioni inviano il beacon con una frequenza troppo elevata. Questo per
poca conoscenza dei criteri di funzionamento o, peggio, per “eccesso di voglia
di visibilita”. Facendo qualche conto risulta evidente che se si invia il beacon
ogni 3 minuti e lo stesso viene ripetuto 5, 6 o piu volte ed il tempo di
trasmissione di un pacchetto & di circa 1 secondo, moltiplicandolo per 100 o
piu (numero medio di stazioni presenti in frequenza), vediamo cosa succede:
UN GRAN CAOS! Teniamo presente poi che quasi tutte le stazioni inviano
anche lo STATUS TEXT che € a tutti gli effetti un altro beacon, quindi il tutto &
raddoppiato.

1.1 L’invio del beacon dovrebbe essere configurato secondo la tabella

seguente.

Tipo di stazione Temporizzazione in minuti
Stazione fissa normale 20

Stazione fissa meteo 10

Stazione mobile in movimento (TM-D700 o TH-D7) | 1 o 30 sec.

Stazione mobile ferma (TM-D700 o TH-D7) 10

Stazione mobile (Tiny Trak con smart beaconing) Automatico

Digipeater 25

Internet 10

1.2 Di seguito una tabella su come impostare la temporizzazione del beacon
sia in UI-View che in apparati dedicati.

Tipo si software o apparato

Menu

UI-View (stazione fissa)

Setup -> Station setup -> Fixed -> 20 -> OK

UI-View (stazione meteo)

Setup -> WX station setup -> Radio -> 10 -> OK

Stazione fissa (TM-D700)

Menu 3-D -> 20 min -> OK

Stazione fissa (TH-D7 G2)

Menu 2-D (TX INTERVAL) -> 20 min -> OK

Stazione fissa (TH-D7 1° ver.)

Menu 2-7 (TX INTERVAL) -> 20 min -> OK

Stazione mobile (TM-D700)

Menu 3-D (TX INTERVAL) -> 30 sec 0 1 min -> OK

Stazione mobile (TH-D7 G2)

Menu 2-D (TX INTERVAL) -> 30 sec 0 1 min -> OK

Stazione mobile (TH-D7 1° ver)

Menu 2-7 (TX INTERVAL) -> 30 sec 0 1 min -> OK

Tiny Trak

Selezionare lo smart beaconing in programmazione




1.3

1.4

1.5

Un complemento al beacon €& lo Status Text, che invia informazioni
supplementari al beacon principale del tipo: la stazione piu lontana
ricevuta in diretta, la versione del software in uso od un testo libero a
scelta. In caso di trasmissione anche dello Status Text questo deve
essere impostato a non meno di 20 minuti. Di seguito la solita tabella.

Tipo di software o apparato | Menu

UI-View Setup -> Status text -> Interval -> 20 -> OK
TM-D700 Menu -> 3-6 -> selezionare -> OK

TH-D7 G2 Menu -> 2-9 -> selezionare -> OK

TH-D7 1° ver. Menu -> 2-4 -> selezionare -> OK

Una osservazione per le stazioni mobili. Purtroppo molto spesso chi usa
apparti dedicati Kenwood si “dimentica” quando si ferma a lungo tempo
di cambiare la temporizzazione del beacon. Questo comporta un
intasamento della frequenza con dati sempre uguali. Quando ci si ferma
a lungo & opportuno impostare la temporizzazione del beacon a non
meno di 10 minuti.

Per forzare la trasmissione del beacon a tutte le stazioni presenti in
frequenza (che utilizzano UI-View) si pud usare il comando Action ->
Query all stations o premere F11. Per forzare invece la trasmissione del
beacon ad una stazione specifica che si presume possa essere presente
in frequenza, si puo inviargli il messaggio ?APRSP. Un altro malvezzo ¢ il
continuo invio di messaggi del tipo: “non ti vedo in mappa, fai F11”,
oltre ad intasare come sempre inutiimente la frequenza & piu efficace
inviare un ?APRSP. Questo ovviamente, specialmente il Query all station
va usato con molta parsimonia.



Capitolo 2: indirizzamento del beacon

Come ha detto I'autore di UI-View Roger Barker G4IDE il digipeating non & una
scienza esatta. Si tenga sempre presente che si trasmette un pacchetto
digitale non indirizzato ad una stazione specifica e quindi prende una strada
qualsiasi, quindi non si puo sapere a priori chi lo ricevera e chi lo ripetera.

La prima considerazione importante & la distinzione fondamentale fra le
stazioni normali e quelle ripetitrici, cosiddetti DIGI, abbreviazione di
digipeater, contrazione di digital repeater (ripetitore numerico).

Per stazioni normali si intendono i normali utenti operanti da sistemi presidiati
la cui attivita precipua € la trasmissione dei propri dati, indirizzati ad altri
utenti sia in diretta che tramite la rete di digi, ed eccezionalmente la
ritrasmissione di dati di altre stazioni normali.

Per digi si intendono sistemi automatici normalmente non presidiati il cui scopo
principale e ritrasmettere dati ricevuti da utenti normali o da altri digi e
secondariamente l'identificazione di loro stessi.

Detto questo bisogna stabilire a chi indirizzare il proprio beacon affinché venga
ripetuto e quindi le informazioni possano superare la normale portata radio
della nostra stazione. Ogni quanto tempo €& trasmesso il beacon
(temporizzazione) & stato descritto nel capitolo uno, ora vedremo “a chi”
indirizzare le informazioni.

2.1 La parte piu delicata per un buon funzionamento della rete APRS &
I'indirizzamento del beacon. Non dimentichiamoci che utilizziamo
stazioni automatiche che provvedono ad inviare il beacon in tempi e
modalita stabilite dall’'utente, una volta memorizzate le impostazioni
continueranno a trasmettere spesso mai controllate dall’'utente. Ne
consegue che una pessima impostazione genera un eccesso di dati
nelle rete che moltiplicati per il numero degli utenti crea il collasso
totale. Come stabilire a chi si indirizza il proprio beacon affinché
venga ripetuto e quindi vada oltre la portata della propria radio?
Prima di tutto € necessario distinguere la tipologia di stazione in
funzione della propria copertura radio, in pratica la grossa distinzione
e fra stazioni fisse e mobili/portatili. E’ chiaro che una stazione fissa
ha una portata radio maggiore di una mobile/portatile, di
conseguenza una stazione fissa pud raggiungere piu facilmente un
digi lontano affinché i propri dati vengano ripetuti. Per contro una
stazione mobile/portatile ha minor copertura radio e quindi necessita

di “qualcuno” piu vicino che possa raccogliere i suoi dati e
ritrasmetterli ai digi piu lontani. Per questo motivo € consigliabile
utilizzare due indirizzamenti diversi del beacon.



2.2 La filosofia di funzionamento dei digi APRS e a "LIVELLI", che sono
semplificati nella tabella seguente.

Tipo Livello | Utilizzo e destinazione indirizzamento

RELAY Basso Ripetizione di mezzi mobili ad aree locali o a digi di alto livello

WIDE Alto Ripetizione di stazioni fisse o ritrasmissione delle ripetizione ricevute dai

(obsoleto) RELAY

WIDEN-n Alto Ripetizione di stazioni fisse o ritrasmissione delle ripetizione ricevute dai
RELAY con SSID a scalare

TRACEN-n Alto Ripetizione di stazioni fisse o ritrasmissione delle ripetizione ricevute dai
RELAY con SSID a scalare con identificazione del digi

Nota: per n si intende un numero compreso fra 0 e 15 (es. TRACE4-4).

2.3

2.4

Una breve ma necessaria spiegazione sul funzionamento del SSID a
scalare. Ogni qualvolta un pacchetto indirizzato ad un digi con SSID a
scalare (WIDEn-n o TRACENn-n) viene ripetuto, I'ultimo numero viene
scalato di una unita. Ad esempio un beacon indirizzato a TRACE3-3
dopo la prima ripetizione diventera TRACE3-2, poi TRACE3-1 e
quando diverra TRACE3 (non esiste 3-0) non sara piu ripetuto.

Molte discussioni e differenti punti di vista sono stati espressi in
questi anni sull’indirizzamento del beacon. Sostanzialmente si tratta
di adottare l'indirizzamento a WIDEn-n o TRACEn-n. I sostenitori della
tesi del WIDEn-n adducono come vantaggio la minor lunghezza del
pacchetto con tutti i vantaggi facilmente immaginabili, ma questo &
I'unico punto a favore del WIDEn-n. Il TRACEn-n introduce ad ogni
ripetizione il nominativo del digi che ha ripetuto l'informazione e
quindi tutto il pacchetto Si allunga.

2.4.1  WIDEnN-n. Pro: pacchetto piu corto.
2.4.2 Contro: non si vede il path del pacchetto e quindi non si sa

quale digi lo hanno ripetuto. Con questo sistema non si puo
stabilire quale digi usare per inviare un messaggio ad una
stazione che non si riceve in diretta.

2.4.3 Contro: non si sa quali digi funzionano e quali no.
2.4.4 Contro: se una stazione non autorizzata si attiva come digi ad

ampia copertura non si vede.

2.4.5 Contro: non si possono identificare doppie ripetizione in zone al

alto numero di digi.

2.4.6 Contro: non si vededono interessanti fenomeni di propagazione

del segnale.

2.4.7 Contro: quando si trasmette la conferma di ricezione di un

pacchetto (ack) non sapendo da quali digi e’ stato ricevuto il
messaggio ritrasmette l'ack a digi generici WIDEN-n
coinvolgendo quindi una gran quantita di digi che interessano
I’'area di pertinenza.




2.4.8 TRACEn-n. Contro: pacchetto pitu lungo, anche se con gli

accorgimenti descritti in seguito si puo contenere la lunghezza.

2.4.9 Pro: si vede il path del pacchetto e quindi si vede quali digi lo

hanno ripetuto. Importante per stabilire quale digi usare per
inviare un messaggio ad una stazione che non si riceve in
diretta.

2.4.10 Pro: si vede quali digi funzionano e quali no.
2.4.11 Pro: se una stazione non autorizzata si attiva come digi ad

ampia copertura si vede.

2.4.12 Pro: si vedono eventuali doppie ripetizioni.
2.4.13 Pro: si vedono i fenomeni di propagazione.
2.4.14 Pro: quando si trasmette la conferma di ricezione di un

2.5

2.6

2.7

2.8

pacchetto (ack) percorre in senso contrario la strada "tracciata"
dal proprio beacon senza interessare tutti gli altri digipeaters
come farebbe il WIDEnN-n.

Dopo molte osservazioni fatte, credo che un buon compromesso fra
un pacchetto non eccessivamente lungo e tutti i vantaggi dell’utilizzo
del TRACEn-n sia l'adottare un TRACE con poche ripetizioni, con un
massimo di 4 ripetizioni. Ribadisco che l'obbiettivo dell’APRS e quello
di una buona copertura e affidabilita delle informazioni trasmesse in
grandi aree locali, non fare DX (vedi introduzione).

In considerazione di quanto sopra ecco la tabella di
configurazione di indirizzamento del beacon:

Tipo di stazione | Impostazioni UI-View Impostazioni RTX Kenwood

Mobile/portatile | APRS,RELAY,TRACE3-3 | RELAY,TRACE3-3

Fissa APRS, TRACE4-4 TRACE4-4

E’ importantissimo che le stazioni fisse non indirizzino il
proprio beacon a RELAY, questo dev'essere lasciato come
punto di accesso alle stazioni mobili/portatili che hanno meno
copertura radio e quindi necessitano di un punto intermedio
per I'accesso ai digi ad ampia copertura.

E’' ancora piu da evitare l'invio del beacon a path multipli tipo
RELAY,WIDE7-7,TRACE7-7. In questo modo le ripetizioni sono
eccessive (nell’'esempio 1+7+7=15). Cosi facendo si genera
una quantita di ripetizioni tali da occupare eccessivamente la
frequenza ottenendo come risultato di lasciare meno spazio
alle altre stazioni. Avete presente chi usa i kilowatt in 40 metri
per parlare da Roma a Milano?



2.9 Di seqguito la tabella su dove andare a mettere le precedenti

impostazioni:

Tipo di software o apparato

Menu

UI-View (stazione fissa)

Setup -> Station setup -> Unproto address -> APRS,TRACE4-4

Kenwood TM-D700 (fisso)

Menu 3-B Packet Path -> TRACE4-4 -> OK

Kenwood TM-D700 (mobile)

Menu 3-B Packet Path -> RELAY, TRACE3-3 -> OK

Kenwood TH-D7 (fisso)

Menu 2-8 Packet Path -> TRACE4-4 -> OK

Kenwood TH-D7 (mobile)

Menu 2-8 Packet Path -> RELAY,TRACE3-3 -> OK

Kenwood TH-D7G2 (fisso)

Menu 2-B Packet Path -> TRACE4-4 -> OK

Kenwood TH-D7G2 (mobile)

Menu 2-B Packet Path -> RELAY, TRACE3-3 -> OK




Capitolo 3: caratteristiche del digipeater

La catena dei digi € la struttura portante della rete APRS. Questi permettono
ad un segnale anche minimo di coprire vaste aree locali. E’ evidente che le
strategie da adottare per i digi devono essere accurate per fare in modo che
tutto funzioni a dovere. La prima considerazione importante da fare e che i
ripetitori digitali APRS si differenziano dai normali ripetitori analogici in fonia
per diversi aspetti. Prima di tutto i digi APRS sono tutti non solo sulla stessa
banda dei 2 metri, ma addirittura sulla stessa frequenza di 144.800 MHz a
differenza dei ripetitori analogici fonia che vanno dai 29 MHz fino ai GHz.
Inoltre i ripetitori analogici hanno toni sub-audio diversi che consentono un
accesso selettivo mentre in APRS in linea di massima non possiamo stabilire a
priori quale digi ripetera il nostro segnale. Per questi motivi ed altri
necessitano di una struttura di coordinamento piu organizzata in modo da
ottimizzare il loro funzionamento.

Le caratteristiche a cui dovrebbe rispondere un digi APRS sono:

Ottima copertura radio

Presenza in aria costante

Affidabilita

Non vicinanza con altri digi

Ubicazione in aree ad alta densita di utenti o in altura
Possibilita di controllo da remoto e SysOp attento
Coordinamento

Nouhkwhe

3.1 Copertura radio. E’ abbastanza evidente il significato, questa
caratteristica e’ comune a qualsiasi tipo di ripetitore. Il fatto di
essere in posizione strategica e quindi con buona copertura radio
garantisce una buona diffusione del segnale.

3.2 Presenza costante in frequenza. Purtroppo molto spesso si assiste
all’attivazione di digi che dopo breve tempo spariscono. Questo per
prove improvvisate o altri motivi. Questo comporta disfunzioni nella
rete specialmente per quanto riguarda la pianificazione di altri digi.

3.3 Affidabilita. Il criterio generale per |'approccio alla gestione di un
ripetitore radioamatoriale dovrebbe essere di tipo professionale e
cioe I'impianto deve essere realizzato con la massima cura tenendo
presente che spesso si tratta di installazioni non presidiate e difficili
da raggiungere. Un impianto eseguito con criteri professionali
significa affidabilita nel tempo.

3.4 Vicinanza con altri digi. Da evitare assolutamente l'installazione di
digi in prossimita di altri. Digi vicini oltre ad essere inutili e dannosi,
accorciano la distanza che un pacchetto APRS pud percorrere in
quanto scalano I’'SSID in poca distanza (vedi punto 2.3).
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3.5

3.6

3.7

3.8

Ubicazione. E’ evidente che la scelta su dove installare un digi deve
essere fatta anche in base alla quantita di utenti da servire e di
conseguenza la locazione dovrebbe essere scelta in base all’area piu
vasta possibile che il digi dovrebbe servire.

Come al punto 3.3 ho accennato a criteri di professionalita
nell’installazione, sarebbe auspicabile che il digi possa essere
attivato e configurato da remoto in modo da poter variare la
configurazione in qualsiasi momento. Inoltre la scelta del sysop
(SYStem OPerator, colui che si occupa del funzionamento) dovrebbe
essere fatta in base alle competenze, alla disponibilita e alla
reperibilita del sysop. Sembra banale ma troppo spesso ci sono digi
che sono installati, dimenticati e non si sa piu chi e come li gestisce.
Utile anche mettere nel beacon del digi il home del SysOp in modo
che chiunque possa avere un riferimento per segnalare eventuali
problemi o malfunzionamenti.

Coordinamento. E’ il punto piu importante. La rete digi deve essere
coordinata e organizzata. Un coordinatore nazionale dovrebbe
tenere l'elenco dei digi, la loro ubicazione, l'area di copertura, i
SysOp responsabili. Questo per ottimizzare la loro copertura.
Sarebbe opportuno sfoltire dove ce ne sono troppi e metterne dove
mancano.

Una stazione normale non si deve assolutamente configurare
come digi. Anche per fare delle prove. Questo per evitare
tutti i problemi descritti in questo capitolo. Accertarsi quindi
che nel menu di UI-View -> Setup -> Digipeater Setup non ci
sia spuntata la casella Enable Digi. Non c'é nessuna
sperimentazione nel configurare la propria stazione come
digi ad alto livello. Non vedo quale sia la sperimentazione
nello spuntare la casella “enable digi” e vedere che si é
diventati un digi, e logico che funziona! L'unico effetto che si
ottiene é quello di creare ulteriore caos a quello gia
esistente. Ci sono pero delle eccezioni che riguardano alcune
stazioni normali configurate come digi RELAY. Chi ritiene di
essere in una posizione strategica, buona copertura radio,
sufficientemente lontano da digi ad alto livello e da altri
eventuali digi Relay, chi ha una presenza costante in
frequenza, chi abita in centri urbani medio/grandi dove &
difficile per i mezzi mobili/portatili accedere ai digi ad alto
livello, si puo configurare come digi RELAY. Questo
subordinato ai criteri di cui sopra, con l'identificazione del
proprio digi (Setup -> Digipeater setup -> Alias substitution,
proprio nominativo nel sub alias e impostare come sub
aliases RELAY,PROPRIO_NOMINATIVO.
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Capitolo 4: messaqggi

I messaggi in APRS sono uno strumento molto valido ma se usati male sono
una delle principali cause dell’'aumento sconsiderato e inutile del traffico in
rete. Di seguito alcune norme di comportamento che si dovrebbero osservare
per un utilizzo corretto.

4.1

4.2

4.3

Non dimentichiamoci che siamo Radioamatori e quindi il contenuto
delle conversazioni deve essere conforme al codice di
regolamentazione delle comunicazioni radioamatoriali. I messaggi in
APRS non devono essere una “chat” o peggio. Purtroppo si assiste
gia al penoso spettacolo dei ripetitori in fonia, qui non solo si rischia
che il contenuto raggiunga tutto il mondo grazie ai server
RF/internet ma rimane tutto scritto e memorizzato.

Limitare le conversazioni allo stretto necessario che non giustifichi
l'uso della fonia. Utilizzare la scrittura minuscola, il tutto maiuscolo
equivale ad alzare il tono della voce e non sta bene.

Prestare la massima attenzione al campo digi della finestra
messaggi. Sull’argomento anni fa avevo gia sottoposto il
problema a Roger G4IDE ma purtroppo la malattia I'ha
portato via prima che potesse modificare UI-View. Il fatto e
questo: se non si specifica niente nel campo digi della
finestra messaggi di UI-View il programma trasmette il
messaggio utilizzando come path cio che é stato impostato
nell’'unproto address (vedi punto 2.6). Quindi se
trasmettiamo un messaggio alla stazione a pochi Km di
distanza senza specificare niente del campo digi in effetti il
nostro messaggio percorrera tutta la rete digi e sara visibile
per una vasta area in RF e per tutto il mondo tramite
internet. Cosa mettere allora nel campo digi? Prima di tutto
se il destinatario dei messaggi e ricevuto in diretta (lo si
vede nei dettagli della stazione nella finestra effective digi
path che e vuota) nel campo digi della finestra messaggi
dovra essere scritto qualcosa che non sia un nome di un digi
o un indirizzamento per i digi. Si potrebbe scrivere LCL,
oppure 1, oppure LOCALE, oppure PIPPO eccetera; insomma
qualsiasi cosa purché non venga lasciato il campo vuoto. Se
invece la stazione destinataria del messaggio é ricevuta
tramite la ripetizione di uno o piu digi si digita il o i digi con
cui e stata ricevuta nel campo digi della finestra messaggi.
Da questo si capisce immediatamente la grande differenze
fra WIDEn-n e TRACEn-n, col primo non sapremmo mai da
quale digi abbiamo ricevuto una stazione con TRACEn-n si!
Tutto questo vale solo per UI-View ovviamente. Per gli
apparati dedicati Kenwood non é possibile.

12



Capitolo 5: varie

Qui di seguito saranno elencati comportamenti vari che possono risultare
dannosi per il buon funzionamento del sistema APRS.

5.1

5.2

5.3

5.4

5.5

Emergenze. Il trasmettere un segnale di emergenza senza che
corrisponda al vero non solo € un comportamento irresponsabile a
prescindere dall’APRS, ma attiva nei ricetrasmettitori dedicati
Kenwood I'allarme emergenza che consiste nella scritta
“"EMERGENCY!” a tutto schermo e nell’emissione di segnali acustici.
Questo e assolutamente da evitare, anche solo per fare delle
prove.

Nominativi. Sembra assurdo ma mi trovo nella necessita di
ricordare che ogni Radioamatore & in possesso di un nominativo
radio rilasciato dal Ministero ed € quello che va usato. Identificativi
come “CER”, ""ARIRE"”; “PROCIV”, ed altri di questo genere sono
FUORILEGGE!

Oggetti. Cosa sono ? Sono indicazioni virtuali che una stazione
trasmette per segnalare qualcosa di rilevante e degno di
importanza agli altri. Non sono stazioni vere. Si riconoscono perché
il fondo della casella € azzurro. Qui si e visto di tutto e di piu. Dalla
fiera paesana al ristorante dell'amico passando per l'oggetto di se
stessi posizionato nella stessa posizione della stazione. Sono
assolutamente inutili!. La segnalazione di una sezione ARI puo
essere utile ma interessa solo localmente, quindi € da trasmettere
solo in ambito locale senza interessare la rete di digi per la
ripetizione. Per la segnhalazione dei ripetitori sarebbe meglio creare
degli overlays che la stazione interessata alla visualizzazione dei
ripetitori si carica in loco senza trasmetterli in aria. Attenzione
anche agli oggetti che indicano condizioni meteo. La segnalazione
di un evento meteo particolare va bene ma deve essere fatta con
attenzione e non dimenticata in trasmissione per ore o giorni
anche quando l'evento € passato ma soprattutto la fonte delle
informazioni deve essere sicura. Ad esempio una buona fonte di
informazioni meteo potrebbero essere i Volmet aeronautici (Milano
su 126.6 MHZz).

Icone. L’icona € il primo colpo d’occhio che si ha su una stazione,
la sua scelta deve rappresentare la caratteristica delle stazione e
quindi corrispondere alla realta. La classica casetta gialla per le
stazioni normali va bene, se si & attivi anche in HF quella verde.

SSID. L'SSID (Station Supplementary IDentification) agli albori
dell’lAPRS serviva ai primi programmi per APRS in DOS per
assegnare l'icona alla stazione, ora non e piu cosi ma gli SSID
tornano utili per identificare alcune tipologie particolari di stazione
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5.6

5.7

5.8

o per distinguere stazioni diverse di uno stesso nominativo. In
particolare su usa: 0 per le stazioni fisse normali, -7 portatili, -9
automobili, -10 motociclette, -11 digipeater (in Italia), -12 jeep, -
13 camper, -14 autocarri, -15 furgoni. Gli altri, specialmente -2, -3
possono essere utilizzati per identificare le altre stazioni secondarie
presenti in frequenza del medesimo nominativo.

Beacon Comment. II Beacon Comment € una informazione
trasmessa assieme al beacon il cui contenuto € un testo di campo
libero. Per inserire le informazione del Beacon Comment bisogna
selezionare il menu Setup poi Station Setup e scrivere i dati nella
casella Beacon Comment. Cosa € utile e cosa no. E’ utile scriverci il
proprio nome e il QTH. E’ utile inserire anche la propria e-mail o la
frequenza su cui si € QRV in fonia per indicare metodi per essere
contattati alternativi all’/APRS. Cosa non € utile. E’ assolutamente
inutile scriverci il nominativo in quanto €& gia trasmesso
automaticamente e sarebbe quindi una informazione doppia. Il
nominativo si vede gia nell'icona. Evitare caratteri inutili come
punti, asterischi e lineette a gogo. Oltre a trasmettere dati
assolutamente inutili che contribuiscono solo ad allungare i
pacchetti, i TH-D7 ed i TM-D700 non Vvisualizzerebbero
I'informazione in quanto hanno una capacita limitata del display a
rispettivamente 25 e 28 caratteri percido se iniziamo il Beacon
Comment con una serie di asterischi chi riceve con tali apparati
vede solo quelli e non l'informazione utile. Ribadisco di scrivere
minuscolo, il maiuscolo significa alzare il tono della voce e questo
non € bello.

Gateway Internet/RF. Molto bene ovviamente prendere i dati radio
per immetterli nella rete internet, attenzione al contrario. Che
senso ha vedere delle stazioni lontane che si possono contattare
solo tramite un gateway internet?

Bollettini. Un altro ottimo strumento di diffusione di massa di
notizie usato spesso male. I bollettini servono a comunicare a tutti
gli utenti avvenimenti importanti che richiedono attenzione. Le
situazioni di routine possono essere segnalate nel Beacon
Comment o nello Status Text. Porto ad esempio di cosa NON si
deve fare: un noto IK2 di Milano che da mesi propaganda le sue
mappe martellando la rete di bollettini contenenti informazioni non
solo straconosciute, ma che potrebbero essere portate a
conoscenza degli utenti nei modi sopra descritti creando molto
meno traffico inutile.

14



Conclusioni

Questi sono esempi della validita e della potenzialita dell'lAPRS. Concludo
affermando che tutto questo non € la soluzione magica a tutti i problemi della
rete APRS, sono semplici osservazioni fatte da chi € in continua attivita dal
dicembre 1999, ha raccolto i pareri di chi e attivo e fattivo in APRS da tempo e
ha passato tanto tempo in monitor.

Se qualcuno ha dei consigli o correzioni da apportare saro felice di integrarle in
questo scritto che ha come unico obiettivo quello di far funzionare al meglio la
rete APRS.

L'’APRS ha delle potenzialita incredibili, specialmente nelle applicazioni della
Protezioni Civile. Molte di queste potenzialita non sono state descritte qui per
semplicita, purtroppo spesso € usato male per non conoscenza delle regole, o
peggio, per spregio. Inoltre & accessibile a chiunque anche con pochi mezzi,
quasi tutti hanno in casa un computer ed una RTX FM in 2 metri.

Un tale IW20.. di Milano ha scritto in rete che “In APRS si puo fare quello che
si vuole, tanto non ci sono regole” a parte la dimostrazione del livello di
intelligenza dell’individuo ora le cose sono cambiate.

Il nuovo Consiglio Direttivo dell’ ARI ha dimostrato sensibilita verso questa
tecnologia attiva da anni in Italia che coinvolge centinaia di appassionati. Dove
prima non esisteva nessun organo ufficiale ma solo gruppi che dettavano
regole spesso in contraddizione fra loro, il CD ARI ha ritenuto opportuno creare
una Coordinatore APRS come ne esiste uno per i ripetitori, i beacon, i 50 MHz
ed altro. Ha affidato a me il compito di gestire e coordinare I’APRS. Cerchero e
faro tutto il possibile per recuperare il tempo perduto e chiedo la
collaborazione di tutti.

L’APRS & una tecnologia dalle grandi applicazioni se usato adeguatamente, non
facciamolo diventare un giochino stupido!

73, Marco IK2CHZ - K2CHZ
Coordinatore APRS ARI

Email: ik2chz@ari.it
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